
Sun City Summerlin Computer Club

Seminar

Video Editing With OpenShot

Tom Burt



Seminar Agenda

• Introduction

• Shooting Digital Videos and Photos

• Moving Videos and Photos to Your PC

• Getting the Free OpenShot Video Editor

• Overview of the Process

• OpenShot Editing Basics

• Project – Photo Slide Show

• Project – Home Movie for YouTube

• Downloading a Video to a Device

• Uploading a Video to YouTube

Video Editing With OpenShot



Introduction

• This seminar updates and consolidates material I’ve presented over past 9 

years on video editing.

• Modern smart phones all have the ability to shoot digital videos.

• The challenge is how to take those raw video clips and photos and 

produce finished videos that you can publish on YouTube, Facebook and 

other social media sites.

• Today, we’ll walk through the end-to-end process for you.

• We’ll use the free OpenShot as our video editing tool. Much of what we do 

can also be done in Pinnacle Studio, NCH VideoPad, iMovie and other 

video editing tools.

• Along the way, we’ll also touch on some other useful tools.
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Video Editing With OpenShot

The Android Camera App

• Your Android phone or tablet has one or more built-in cameras.

• Before taking photos, gently clean the camera lens with a soft microfiber 
cloth.

• To take photos, you first need to launch the camera App by tapping its icon 
on the home screen.

• The Camera App displays what either the front or rear camera lens sees 
along with a number of visible controls.
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Taking Photos of Subjects in Front of You

• Aim the camera at your subject and check how the subject 
appears on the screen.

• If in low light, consider turning on the flash (icon on screen).

• Generally best to hold the camera horizontally; you can crop and 
resize later.

• Hold the camera steady and level, aimed at the subject, with your 
arms close to your body to prevent jerking.

• Tap the main subject on the screen to tell the camera what to 
focus on.

• Make sure your fingers aren’t in front of the lens or flash!

• To take the picture, either press the camera icon on the screen or 
press either volume button. DON’T jerk up or down when pressing 
the button!!

• The picture will be saved as a .jpg image file in the DCIM folder.
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Taking Selfies With Your Phone

• Tap the “Switch camera” icon to select the front camera (the one 
facing you) or drag in any direction.

• You will now see yourself (and whatever is behind you) on the 
screen.

• Note – the Flash won’t help for a Selfie!

• Move the camera toward or away from yourself as needed to get 
yourself into the desired position.

• Tap the main subject on the screen to tell the camera what to 
focus on.

• Hold the camera steady with one or two hands and then press one 
of the volume buttons to take the picture. DON’T jerk up or down 
when pressing the button.

• The picture will be saved as a .jpg image file in the DCIM folder.
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Recording Video Clips With Your Phone

• Start the Camera App.

• Tap the “switch camera” icon to select the rear camera.

• Aim the camera at your subject and check how the subject appears on the 
screen.

• If in low light, consider turning on the flash or auto-flash (icon on screen).

• Generally best to hold the camera horizontally; you can edit later.

• Hold the camera steady and level, aimed at the subject, with your arms 
close to your body to prevent jerking.

• Make sure your fingers aren’t in front of the lens or flash!

• To begin recording the video, tap the Video button on the side of the 
screen. The microphone and video camera will both turn on.

• Your tablet or phone will record video and sound and save it as a video file 
in the Gallery folder.

• You can pause recording by tapping the Pause icon; resume by tapping 
the red dot.

• You can stop recording by pressing the square icon.
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Moving Photos To / From Your Device (1)

• If you have set up a free Google Account and connected 
your Android Phone to it, the phone will automatically sync 
your photos and clips to your on-line Google Photos 
storage.

• .JPG photos < 2 Megapixels don’t count against your free storage.

• Google Drive has a 17 GB storage limit (with exceptions).

• Photos on Google Photos will also sync from Google’s 
cloud to your PC or Mac and other devices that have 
Google Drive or Google backup and Sync installed.

• So having a Google account means photos you take on 
your phone are immediately backed up to the Google 
Photos cloud and can also be automatically copied from 
the Google Photos cloud to your PC, Mac or other device.
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Moving Files To / From Your Device (2)

• After your device is plugged in, you may need to 
change it from charging to “data” mode.

• Swipe down from top and then tap the “Change 
USB options” band.

• In the screen that appears, tap the bubble for 
“Media Sync (MTP). Finally tap either JUST ONCE 
or ALWAYS.

• Windows will detect the device and open a File 
Explorer window displaying the device’s file 
system.

• You can use normal Windows actions to copy 
files back and forth, delete files, rename – all the 
usual things.

• This works well for large files like videos and 
music.

You can also plug your device, via a USB cable, into a USB port on your PC.



Getting Some Useful Tools

• OpenShot Video Editor (Version 2.5.1)
• https://www.openshot.org/

• Windows Live 2012 Full Setup (Includes Movie Maker 2012)
• http://web.archive.org/web/20170112124505/http://wl.dlservice.microsoft.com/download/C/1/B/C1BA42

D6-6A50-4A4A-90E5-FA9347E9360C/en/wlsetup-all.exe

• NCH VideoPad (Version 6.0) – Free trial, $39.95 for Home Edition
• https://www.nchsoftware.com/videopad/index.html

• http://www.nchsoftware.com/videopad/tutorial.html?ref=nlssub.tutorial.WinEN.20180216

• DVDShrink (free)
• Version 3.2.0.15 (converts a commercial DVD to an unlocked format)
• http://www.softpedia.com/get/CD-DVD-Tools/CD-DVD-Rip-Other-Tools/DVD-Shrink.shtml

• HandBrake (free)
• Version 1.3.1 (Converts videos & DVDs to other formats)

• http://handbrake.fr

• iTunes (free media player, organizer, sync tool for iPhone/iPad, Windows-only)
• http://www.apple.com/itunes/download

• VideoLan VLC Media Player (free; plays everything)
• https://www.videolan.org
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Overview of the Video Editing Process
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OpenShot Basics (1)
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OpenShot Basics (2)

• Timeline
• Free version of OpenShot supports any number of timelines.

• Each timeline can contain video clips, photos or sound.

• Can zoom the on-screen timeline to get finer resolution

• Can add many clips or photos in succession to the timeline; just drag and drop 

from the clip area.

• Can move clips / photos around on the timeline; just drag and drop

• The timelines work like layers in photo editors.

• If multiple audio timelines, can mix the audio in the final output video file.

• Editing shortcut keys
• Ctrl+A (Select All)

• Ctrl+C (Copy)

• Ctrl+V (Paste)

• Ctrl+Y (Edit > Redo)

• Ctrl+Z (Edit > Undo)
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OpenShot Basics (3)

• Moving, Inserting and Deleting Clips

• Can use drag and drop to move clips.

• Place the time marker and then right click a new clip and choose “Add 

to timeline” to insert it.

• Right click a clip or photo and then select “Remove clip” to remove it.

• Cutting

• To split a clip into two, set the time marker, right click and select Slice. 

Then delete or move one of the parts. Can also use the scissors tool.

• Can use the Time property to adjust playback speed slower or faster.

• Adding Titles and credits

• Click the Title menu to generate a title clip.

• Edit the title’s text, colors and other properties. Adjust its duration.

• Then drag that title clip to the desired place on the Timeline.
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OpenShot Basics (4)

• Photo durations
• You can select one, several or all photos and set the duration each is to be 

displayed. 7 to 10 seconds usually works well. It’s easiest to do this when first 

adding a group of photos to the Timeline.

• Making Your Video – “Export Video”
• When everything is set up, click the red “Export” button.

• Browse to a destination folder and click “Select folder”.

• Enter a file name (default is your project name).

• Choose your export Profile: e.g. “All Formats”

• Choose a target file type (e.g. MP4) and resolution

(e.g. HD 720p 30 fps (1280x720).

• Click “Export Video”

• OpenShot will write the finished file of your video to the specified file and folder. 

For longer videos with higher resolution, this can take significant time.
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Video Slideshow Project (1)

• Combine a set of photos into a slide show video, with titles, 

transitions, credits and soundtrack.
1. Go to File > “Import Files”. A file chooser dialog will open.

2. Navigate to a folder and select the photos you want in the slideshow.

3. Click the Open button. The photos will be loaded into the clips area.

4. Select one or more photos in the clips area. Right click and choose “Add to 

timeline”. Or drag photos onto the timeline.

5. Drag photos on the timeline to get them in the desired sequence.

6. Click the Title menu to create one or more Title clips.

7. Edit each Title clip to suit. You can set the text, font, size and color.

8. Place the time marker, right click the Title clip and choose “Add to timeline.

9. As desired, select, configure and insert a transition.

10. Preview your video to make sure everything is right. Tweak as needed.

11. Export the finished video as a 720P video file.
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Video Slideshow Project (2)
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Video Movie Project (1)

• Combine 3 clips of the Tappers May 2013 Rehearsal into a single 

MP4 video with titles, transitions and credits.

1. Import the 3 clips. Click “Add File(s)”. Choose the video files to 

include in the project.

2. Drag the clips onto the video track in the desired order. You can drag 

them around afterward if they’re not in the right order.

3. Click the Title menu. Choose a template.

4. Edit the Title wording to suit and set its duration, colors, fonts and 

scrolling / fading effects. Save the Title as a clip (file).

5. Drag the Title clip to the front of the Timeline.

6. Slice and crop any unwanted material from the start and end of each 

clip.

7. Drop a simple black 3-second fade out/in between each clip.

8. Preview again to make sure everything is right.

9. Export the finished video as a 720P MP4 video file.
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Video Movie Project (2)
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Downloading an MP4 to a Device

• From a Windows PC to an Apple Device (iPod, iPhone, iPad):

• Start iTunes

• Add the newly rendered MP4 file to your iTunes Library

• Plug in your i-device via the USB adapter

• iTunes will then offer to synch the MP4 file to the i-device

• From a  Windows PC to an Android Device (tablet or phone)

• Plug in your Android device via the USB adapter.

• Windows will open the device in Explorer with a new drive letter.

• Use Copy / Paste or Ctrl-drag to copy the MP4 file to a folder on your 

Android device.

• If your Android device has a SD card slot, you can instead plug the SD 

card into your PC’s card reader or USB adapter and copy the file to the 

SD card.

• Then plug the SD card into your Android device.
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Transferring a Video to YouTube

• Log in to www.YouTube.com. 

• If you don’t have a Google account, you will first need to create one.

• Once you are logged in, you may need to create a public channel. 

That will allow you to upload video files and share them.

• Next, go to the Dashboard.

• Click the “Upload a Video” button.

• Navigate to the video you wish to upload and click OK.

• YouTube will upload the video and provide a hyperlink that you 

can send to others. (For example …)
• http://www.youtube.com/watch?v=DMUAxKibRp4&feature=youtu.be

• *** Caution ***

• Be careful uploading videos to YouTube that use commercial music in 

the background. You may run afoul of the copyright police.
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